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1. Tutorial Página Personal 

1.1. Introducción 

En el siguiente documento vamos a explicar brevemente como editar nuestra página personal 
utilizando la nueva plantilla de la UAL. Además, también se explica como utilizar uno de los editores de 
HTML para poder trabajar con la plantilla de la página personal. 

1.2. Tutorial de edición de páginas web con Kompozer 

En el siguiente apartado vamos a explicar como utilizar el editor de HTML KompoZer. 

1.2.1. Descarga del programa 

En primer lugar, visitaremos la página web http://kompozer.net/ donde podremos descargar el software 
que necesitamos. Para ello, pincharemos en el enlace que hemos marcado.  

 

Una vez hecho esto, nos aparecerá una ventana de descarga como la que se muestra en la siguiente 
imagen: 
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Seleccionaremos la opción “Guardar archivo” y pulsaremos el botón aceptar para guardarlo en 
nuestro ordenador.  

Una vez descargado el archivo, necesitaremos descomprimirlo para poder abrir nuestro programa. Para 
descomprimirlo haremos lo siguiente: pulsamos con el botón derecho del ratón sobre el archivo y 
seleccionamos la opción “Extraer aquí” tal y como indica la siguiente imagen.  

 

Esto nos creará una carpeta con todos los archivos necesarios para el programa.  

Por último, solo tendremos que abrir la carpeta y hacer doble click sobre el archivo “kompozer.exe”.  
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1.2.2. Edición de la página web 

Una vez hemos abierto el KompoZer, el primer paso consistirá en abrir la plantilla. Para ello, 
pulsaremos en el botón “Open” de la lista de iconos de la parte superior.  

 

Después seleccionaremos el archivo “Plantilla.shtml” y pulsaremos el botón abrir. Para guardar el 
documento podemos pulsar el botón “Save” si anteriormente ya había sido guardado el documento o sino 
pulsar en la opción del menú “File>Save As…” Si es la primera vez que guardamos el documento, nos 
pedirá el título de la página (este título aparecerá arriba en la barra del explorador cuando visualicemos 
nuestra página).  

A continuación vamos a describir brevemente como insertar algunos de los distintos elementos dentro 
de una página web.  

En la lista de iconos de la parte superior podemos encontrar los siguientes iconos:  

 

• Link: con este botón podremos insertar enlaces a otros sitios web. Necesitaremos escribir el texto 
que queremos mostrar en nuestra página (link text) y la dirección de la página a la cual nos dirigirá el 
enlace (link location). En el siguiente ejemplo hemos puesto un enlace con el texto “Página 
principal de la Universidad de Almería” que enlaza a la página web de la Universidad de Almería. 
Una vez hecho esto, pulsaríamos el botón “OK”.  
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• Image: para insertar imágenes en nuestra página. Una vez seleccionada esta opción, nos aparecerá 
una ventana en la cual nos pedirá una serie de datos como son: image location (dirección de la 
imagen que vamos a insertar) y alternative text (texto que aparecerá cuando posicionemos el ratón 
sobre la imagen). Para ayudarnos a localizar la dirección de la imagen, tenemos un botón con la 
forma de una carpeta abierta que nos servirá para buscar la imagen que queremos poner. Una vez 
hecho todo esto, pulsaremos el botón OK. A continuación vamos a mostrar un ejemplo en el cual, 
hemos insertado una imagen de un limón.  

 

 

Recomendamos hacer una carpeta de imágenes dentro de donde tengamos nuestra página web 
y que, en ella, metamos todas las imágenes que deseemos incluir en nuestra página web.  

• Table: si queremos insertar una tabla en nuestra página web. Nos permitirá seleccionar el número de 
filas y de columnas que tendrá nuestra tabla. Una vez seleccionado el tamaño, nos aparecerá en 
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nuestra página web la tabla con las celdas que hayamos seleccionado. A continuación mostraremos 
un ejemplo de creación de una tabla de tamaño 2x4 (dos filas y 4 columnas). 

 

 

A continuación vamos a mostrar algunas opciones útiles para dar formato al texto de nuestra página. 
Puesto que estas opciones son muy similares a las que podemos encontrar en cualquier procesador de textos 
(como puede ser el Microsoft Word) vamos a describirlas muy brevemente.  

 Para la creación de listas ordenadas.  

 Para la creación de listas con viñetas.  

 Con estos botones podremos poner el texto en negrita, en cursiva o subrayado.  

 Para alinear el texto a la izquierda de la pantalla, centrado, a la derecha o justificado.  

Con el fin de mantener el estilo de la Universidad de Almería, emplearemos los 
siguientes elementos para dar formato al texto:  

• Paragraph: Para introducir un párrafo de texto.  

• Heading2: Emplearemos esto para los títulos superiores de la página. 

• Heading3: Usaremos esto para el título de cada una de las secciones 
dentro de la misma página.  

• Heading4: Para los subtítulos.  

• Heading5 y heading6 para añadir más subdivisiones dentro de cada una 
de las secciones de la página.  

• Recomendamos no utilizar las etiquetas Body Text, Heading1, Address, Preformat y Generic 

container (div) puesto que se utilizan para otros usos y el resultado final de la página podría no ser 
el deseado.  
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Por último, vamos a mostrar como añadir un título a nuestra página. Sino nos lo ha preguntado al 
guardar la página por primera vez o queremos cambiarlo para adaptarlo a las distintas páginas que vayamos a 
crear, tendremos que pulsar en la barra de menú sobre la opción Format > Page Title and Properties... tal y 
como se indica en la figura: 

 

Esto nos desplegará una ventana en la cual podremos poner el título de la página, el nombre del autor y 
una pequeña descripción de la página. El título aparecerá en la barra de título del navegador, mientras que el 
autor y la descripción no se mostrarán en la página, sin embargo, son útiles para los buscadores de internet 
(como por ejemplo Google) para localizar nuestra web. Estos datos no son necesarios para nuestra página, 
pero si recomendamos que se rellenen.  

 

Aconsejamos cambiar el título de nuestra página en cada sección, por ejemplo, si estamos en el 
apartado Docencia de nuestra web, que el título sea “Docencia – Página personal de...”. Además, 
aconsejamos que el texto sea en minúscula poniendo en mayúscula la primera letra del principio de frase o 
de aquellas palabras que deseemos resaltar, evitando en todo caso, poner todo el título en mayúsculas.  
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1.3. Como usar la plantilla 

Junto con el archivo de la plantilla, se suministra una página de ejemplo, la cual nos puede ser de 
utilidad a la hora de desarrollar nuestra propia página. A continuación mostramos la plantilla para las páginas 
personales: 

 

Con esta plantilla.html se puede generar toda una web personal haciendo varias copias de ella y 
editando la información que se muestra. Para ello se puede utilizar cualquier editor de HTML, como 
FrontPage, Dreamweaver o KompoZer, el cual hemos mostrado como funciona en los apartados anteriores. 

Si vamos a tener varias secciones, por ejemplo, descargas, galería, datos personales... tendremos que 
realizar tantas copias de la plantilla como número de secciones vayamos a tener. Por ahorrar tiempo y trabajo 
antes de realizar las copias de la plantilla debemos rellenar los siguientes datos: 
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Una vez editados estos datos, realizamos tantas copias de la plantilla como secciones tenga nuestra 
página, teniendo en cuenta que la página de inicio ha de llamarse index.shtml, ya que sino, no la cargará el 
servidor. Una vez hecho esto, nuestra carpeta quedará de la siguiente manera: 
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A continuación, aconsejamos crear unas carpetas para guardar las imágenes y archivos que se van a 
subir a la página dentro de la misma carpeta de las plantillas, para que luego sea más fácil enlazarlas: 
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Una vez estén creadas las carpetas, tendremos que guardar las imágenes y los archivos ahí antes de 
editar y enlazarlos en la web. Ahora solo tendremos que editar los contenidos de las secciones de la web. 
Esta tarea la podemos hacer rápidamente copiando y pegando la información utilizando cualquiera de los 
editores de HTML mencionados anteriormente: 

 

Y para terminar, una vez tengamos listas todas las páginas, tendremos que editar el menú de la 
izquierda para poder navegar entre ellas. En el caso de que necesitemos más o menos secciones, se podrán 
añadir o quitar elementos de la lista del menú. El nombre del enlace en el menú se editará manualmente, y a 
continuación seleccionaremos la dirección del archivo al que enlazaremos. Esto tendremos que hacerlo en 
todos los elementos del menú: 



 
Web institucional de la Universidad de Almería 

Formación 
 

 

Fecha impresión:  Página 13 de 27 
Fecha de creación:  29/06/2009  
 

 

Y ya habremos finalizado la edición de nuestra página. El aspecto de nuestra página vista en el editor 
web Kompozer sería el siguiente:  



 
Web institucional de la Universidad de Almería 

Formación 
 

 

Fecha impresión:  Página 14 de 27 
Fecha de creación:  29/06/2009  
 

 

Una vez terminado, subiremos todos los archivos, utilizando un cliente de FTP, a nuestra carpeta del 
servidor web donde vayamos a tener nuestra web (nevada, www.ual.es, ...). Para el servidor www.ual.es, los 
subiremos a la carpeta WWW. Esta carpeta WWW deberá ser creada si no existiese. Para ver el aspecto de 
nuestra página web abriremos un navegador web y teclearemos en la barra de direcciones 
http://www.ual.es/personal/ y a continuación el nombre de usuario de Campus Virtual. Allí, el aspecto de 
nuestra página será:   
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Por último, avisaremos al encargado de modificar la web de personas de nuestro departamento para que 
incluya un enlace en nuestra página que apunte a nuestra página personal.  
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1.4. Comprobar la accesibilidad y la calidad 

La página web de la Universidad de Almería tienes una serie de sellos de calidad. Éstos pueden verse 
en la parte inferior izquierda de la página web.  

 

El primero de estos sellos significa que la página web cumple los requisitos de accesibilidad (la norma 
WAI-AA). Si deseamos que nuestra web cumpla estas normas, podremos comprobar el código de nuestra 
web visitando la siguiente dirección: http://www.tawdis.net/.  

 

En esta página, pondremos la dirección de nuestra página web y pulsaremos sobre analizar. Si nuestra 
página tiene errores, tendremos que corregirlos para que se ajuste a dicha norma. Si no sabemos si nuestra 
página cumple la norma o si tiene errores pero no los corregimos, deberemos eliminar dicho sello de nuestra 
página web.  

El último de estos sellos, corresponde a XHTML. Si deseamos que nuestra web cumpla este estándar, 
visitaremos la dirección http://validator.w3.org/ y comprobaremos que el código de nuestra página se ajusta a 
dicho estándar. Esta comprobación se realiza de forma muy similar a como se hace en el caso anterior.  
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Pondremos la dirección donde pone Address y pulsaremos Check. 

En caso de que no deseemos validar nuestra página, deberemos eliminar el sello de ésta.  

1.5. Opciones de edición avanzadas 

1.5.1. Trabajar con acentos y letras propias del español  

Es posible que al subir nuestra página al servidor, las letras acentuadas aparezcan con símbolos o 
caracteres raros. Esto se debe al tipo de codificación. Para evitar estos problemas, deberemos cambiar esta 
codificación para utilizar el formato ISO-8859-1. Esto se modifica de la siguiente forma: En primer lugar, 
pulsaremos en la barra de menú en Format > Page Title and Properties. Esto nos abrirá una ventana como 
la que se muestra en la siguiente imagen: 
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Pincharemos en Choose a charset y seleccionaremos de la lista Western (ISO-8859-1). Pulsaremos 
OK y comprobaremos que en Character set ya aparece ISO-8859-1. Pulsaremos OK y ya estaría todo listo.  

1.5.2. Añadir enlaces a documentos 

Si queremos insertar en nuestra página web enlaces a archivos pdf, archivos de Microsoft Word, Excel, 
archivos comprimidos, etc. lo haremos del mismo modo a como insertamos un enlace a otra web, pero en 
lugar de seleccionar una página web, seleccionaremos el archivo que deseemos poner.  
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Una vez seleccionado el archivo, pincharemos en Advanced Edit..., esto nos abrirá otra ventana como 
la que se muestra a continuación:  
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Pincharemos en Atribute y seleccionaremos la opción class. En value pondremos el tipo de archivo 
que se trate (en nuestro caso pdf). Los diferentes valores que puede tomar se muestran a continuación:  

• pdf: para documentos .pdf 

• doc: para documentos de Microsoft Word.  

• excel: para documentos de Microsoft Excel. 

• zip: para archivos comprimidos, ya sea con Winzip, Winrar, ... 

• swf: para archivos de video.  

• linkExterno: para enlaces que vallan a una página externa de la Universidad. Por ejemplo, 
pondríamos este tipo si pusiésemos un enlace a Google en nuestra página.  

Es muy importante que escribamos estos valores tal y como los hemos puesto, respetando mayúsculas 
y minúsculas, ya que sino no se verá nada.  

1.5.3. Incorporar enlaces de contacto y de sugerencias 

Es posible que queramos añadir en nuestra página web los iconos que aparecen en las páginas de 
servicios de la Universidad de Almería para el “Contacta con nosotros” y el de “Quejas y sugerencias”. Esto 
se hace de la misma forma a como insertamos un enlace en el apartado anterior. Deberemos seguir los pasos 
indicados en el apartado anterior 1.4.2 pero en este caso, el texto que insertaremos en la casilla Value 
correspondiente a la ventana Advanced Property editor (la imagen justo anterior a este texto) será el 
siguiente:   

• quejas: para el icono de quejas y sujerencias. 

• contactaUAL: para el icono de contacta con nosotros.  

Al igual que en el caso anterior, deberemos respetar mayúsculas y minúsculas.  

1.6. Creación de formularios 

A continuación vamos a explicar como se crean formularios. Para nuestro ejemplo, hemos 
seleccionado el formulario de “Contacta con nosotros” del servicio de las tecnologías de la información y las 
comunicaciones,  http://cms.ual.es/UAL/universidad/serviciosgenerales/stic/contacto/index.htm.  

En primer lugar, abriremos la plantilla de formulario plantilla_formulario.shtml y a partir de aquí 
empezaremos a crear nuestro formulario.  
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Al igual que hicimos en nuestra página personal, lo primero que haremos es personalizar nuestra 
plantilla. En primer lugar sustituiremos los (Nombre) por nuestro nombre, pondremos la fecha en la parte de 
abajo, insertaremos las diferentes opciones de menú igual que hicimos en nuestra página personal y 
pondremos el título de nuestro formulario.  

Una vez hecho esto, nos colocaremos en la posición donde queremos insertar el formulario y 
seleccionaremos en el menú la opción adecuada.  
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Ésta nos desplegará el siguiente menú:  

• Define form: para definir un formulario. Aquí le asignaremos un 
nombre a nuestro formulario y la función que tratará los datos del 
formulario.  

• Form Field: para insertar un cuadro de edición de texto en nuestro 
formulario. En las propiedades de dicho cuadro, podemos definir si 
queremos un cuadro de edición normal, uno de tipo password, ... 

• Text Area: para insertar un área de texto. 

• Selection list: para insertar un cuadro desplegable que nos de a elegir 
entre una lista de valores.  

• Define Label: para insertar etiquetas en nuestro formulario.  

• Define Field Set: para definir diferentes secciones dentro de nuestro formulario. En nuestro 
caso, vamos a tener dos secciones. 
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En primer lugar definiremos nuestro formulario. Para ello seleccionaremos Define form... e 
introduciremos el nombre del formulario (nosotros le hemos llamado Contacta), la acción a realizar (el 
programa que tratará estos datos) y el método de envío de los datos (que irá en función de como la aplicación 
captura los datos del formulario para su posterior tratamiento). 

 

A continuación, definiremos las diferentes secciones que tendrá nuestro formulario. Esto se hará 
mediante la opción Define Field Set. Al seleccionar esta opción, nos aparecerá una ventana el la cual 
deberemos introducir el nombre de la sección y le daremos al OK.  

 

 En nuestro caso hemos definido dos secciones, una llamada “Datos de la consulta” y otra “Datos del 
remitente”. Una vez hecho esto, nuestro formulario debería tener el siguiente aspecto:  
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Ahora insertaremos los diferentes elementos dentro de cada sección del formulario. Comenzaremos 
con la sección “Datos de la consulta”. Allí introduciremos dos etiquetas (Label) y dos cuadros de edición 
(Form Field). Para insertar la etiqueta o label, seleccionaremos Define Label y a continuación escribiremos 
el mensaje que queramos que aparezca (en nuestro caso hemos puesto “* Asunto: “). Seguidamente 
insertaremos un cuadro de edición. Seleccionaremos la opción Form field que nos desplegará la siguiente 
ventana:   

 

Aquí podemos definir que tipo de cuadro de edición queremos mediante Field Type. En nuestro caso 
emplearemos el tipo Text. En Field Name pondremos el nombre de dicho cuadro de edición. Si quieres que 
dicho campo tenga un valor inicial, tendrías que indicarlo en Initial Value. En nuestro caso, este valor estará 
en blanco. Por último, indicaremos el tamaño de dicho campo mediante Field Size.  

A continuación vamos a insertar un cuadro de edición para que los usuarios puedan escribir la consulta 
que deseen hacernos. Del mismo modo que en el ejemplo anterior insertaremos una etiqueta mostrando el 
texto “* Su consulta:” y a continuación un área de texto. Para insertar el área de texto seleccionaremos la 
opción del menú Text Area e introduciremos los parámetros apropiados en una ventana como la que se 
muestra en la siguiente imagen:  
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Aquí introduciremos el nombre del área de texto (en nuestro caso, le hemos llamado consulta) y el 
número de filas y de columnas que queremos que tenga (5 filas y 30 columnas). Por último pulsaremos OK.  

Ahora vamos a crear los elementos de la otra sección del formulario (corresponde a “Datos del 
remitente”). En esta sección vamos a solicitar el nombre, los apellidos y el correo electrónico. Para esto se 
utilizarán las etiquetas y los cuadros de texto tal y como hemos realizado en la sección anterior.  

Por último, insertaremos dos botones en nuestro formulario para poder enviar los datos a la aplicación 
(botón de enviar) y otro para limpiar los datos (botón de borrar). Estos dos botones serán insertados fuera de 
las dos secciones pero dentro del formulario.  

En primer lugar nos escribiremos los mensajes que queremos que aparezcan en los botones, en nuestro 
caso sería “Enviar   Borrar”. Nuestro formulario debería tener el siguiente aspecto: 

 

Una vez hecho esto, seleccionaremos el texto “Enviar”, pincharemos sobre las herramientas de 
formulario de la barra de menú y seleccionaremos la opción Define Button. Nos abrirá una ventana en la 
cual tendremos que poner el tipo de botón, el nombre y el valor.  
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Podremos seleccionar entre 3 tipos de botones: 

• Submit: botón para enviar.  

• Reset: botón para borrar los datos del formulario. 

• Button: botón sin ninguna función preestablecida y al cual podremos asignarle el 
comportamiento que queramos.  

 

Para el botón enviar, seleccionaremos el tipo (submit), pondremos el nombre del botón y el valor. Tras 
darle a OK tendremos nuestro botón de insertar ya listo. Para el botón de borrar, haremos lo mismo, pero 
cambiando el tipo de botón (seleccionaremos reset en este caso).  

Nuestro formulario debería quedar con el siguiente aspecto: 

 

Es posible alinear los botones para ponerlos centrados en la página o alinearlos a nuestro gusto. Para 
ello utilizaremos los bototes para alinear el texto de la barra de arriba (tal y como se explica en las primeras 
páginas de este tutorial. Por último, subiremos la página a nuestro sitio web. El resultado obtenido será el 
siguiente:  
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